
 
 

 

 

  



 
 

 

 

 

SYLLABUS (45 Hours) 

Unit Course Contents 

Unit 1 

Introduction to MS Word: 

Creating, editing, saving and printing text documents,  Font 

and paragraph formatting,  Simple character formatting 

Inserting tables, smart art, page breaks,  Using lists and styles,  

Working with images,  Using Spelling and Grammar check, 

Understanding document properties, Mail Merge 

Lab Session: Hands on Practice 

 

Unit 2 

Introduction to MS Excel: Spreadsheet basics,  Creating, 

editing, saving and printing spreadsheets,  Working with 

functions & formulas,  Modifying worksheets with color& 

auto formats,  Graphically representing data : Charts & 

Graphs,  Speeding data entry : Using Data Forms,  Analyzing 

data : Data Menu, Subtotal, Filtering Data,  Formatting 

worksheets, Securing & Protecting spreadsheets 

Lab Session: Hands on Practice 

 

Unit 3 

Introduction to MS Power Point: Opening, viewing, 

creating, and printing slides,  Applying auto layouts,  Adding 

custom animation,  Using slide transitions,  Graphically 

representing data : Charts & Graphs, Creating Professional 

Slide for Presentation. 

Lab Session: Hands on Practice 

Unit 4 

Introduction to Internet: Understanding how to 

search/Google, Bookmarking and Going to a specific website,  

Copy and paste Internet content into your word file and emails,  

Understanding social media platforms such as Facebook & 

Many more 

Lab Session: Hands on Practise 



 
 

 

 

  



 
 

SCHEDULE 

Session Content Time Date 

S1 Introduction to MS Word :  Creating, 

editing, saving and printing text documents 

2 PM – 4 PM 22-Nov-2022 

S2 Font and paragraph formatting,  Simple 

character formatting Inserting tables 

2 PM – 4 PM 23-Nov-2022 

S3 Smart art, page breaks,  Using lists and styles 2PM – 4PM 29-Nov-2022 

S4 Working with images,  Using Spelling and 

Grammar check 

2 PM – 4 PM 02-Dec-2022 

S5 Understanding document properties 2PM – 4 PM 06-Dec-2022 

S6 Mail Merge 2 PM – 4 PM 09-Dec-2022 

S7 Introduction to MS Excel: Spreadsheet 

basics, Creating, editing, saving and printing 

spreadsheets 

2PM – 4 PM 13-Dec-2022 

S8 Working with functions & formulas 2 PM – 4 PM 16-Dec-2022 

S9 Modifying worksheets with color& auto 

formats 

2 PM – 4 PM 20-Dec-2022 

S10 Graphically representing data : Charts & 

Graphs 

2 PM – 4 PM 23-Dec-2022 

S11 Speeding data entry : Using Data Forms,  

Analyzing data : Data Menu, Subtotal, 

Filtering Data 

2 PM – 4 PM 10-Jan-2023 

S12 Formatting worksheets, Securing & 

Protecting spreadsheets 

2 PM – 4 PM 13-Jan-2023 

S 13 Introduction to MS Power Point: Opening, 

viewing, creating, and printing slides 

2 PM – 4 PM 17-Jan-2023 

S14 Applying auto layouts 2 PM – 4 PM 20-Jan-2023 

S15 Adding custom animation 2 PM – 4 PM 24-Jan-2023 

S16 Using slide transitions 2 PM – 4 PM 27-Jan-2023 

S17 Graphically representing data : Charts & 

Graphs 

2 PM – 4 PM 31-Jan-2023 

S18 Creating Professional Slide for Presentation 2 PM – 4 PM 7-Feb-2023 



 
 

  

S19 Introduction to Internet: Understanding 

how to search/Google 

 

2 PM – 4 PM 14-Feb-2023 

S20 Bookmarking, Going to a specific website 2 PM – 4 PM 15-Feb-2023 

S21 Copy and paste Internet content into your 

word file and emails 

2 PM – 4 PM 17-Feb-2023 

S22 Understanding social media platforms such as 

Facebook & Many more 

2 PM – 4 PM 23-Feb-2023 

S23 Computer networks   3 PM – 4 PM 27-Feb-2023 

Exam for Certification Course in Computer 2 PM – 4 PM 03-Mar-2023 



 
 
 

 

Resource Person’s Profile 

Mr KANISHK BHARDWAJ  

Mr.KANISHK BHARDWAJ is a Digital Marketing expert. He has significant experience in 

industry. His core areas are Digital Marketing, Graphic Design, Video Compositing, Creating 

SEO optimized content, Create & manage Google Ad words for company clients, Managing 

Social Media Campaigns, Photoshop, Illustrator, In Design, and After Effects & Premiere 

Pro. 

Academically He has graduated from SRM University ,Chennai . He has earned certificates 

in Digital Marketing Consultant & Executive. He is also certified in Graphic Design and 

Video Compositing.Mr.Bhardwaj's practical experience and proficiency in digital marketing, 

coupled with his educational background and certifications, make him an ideal candidate for 

the role of a trainer for Microsoft Office. His diverse skill set and technological prowess 

provide a solid foundation for effectively training individuals in the use of Microsoft Office 

applications, ensuring a well-rounded and comprehensive learning experience. 
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Name of Course Certification Course in MS OFFICE  

Date 22th November, 2022 to 27th February, 2023 

Venue Computer Lab, MIMT 

Organized by Management Department  

Name of 

External 

Examiner 

Mr.KanishkBhardwaj 

Beneficiary B.Com 2nd Year Students  (95) 

Name of Internal 

Examiner 

Ms.Pooja Sharma 

Objective The aim of this certification course is: 

∙ To give basic information about the computer system.  

∙ To give knowledge about computer hardware and computer software.  

∙ To familiarize students with the use of MS Windows, Internet and E-mail. 

∙ To familiarize students with the use of MS Office-MS Word, MS Excel & 

MS PowerPoint. 

Content Today, computers are used in more environments and for more functions than 

ever before, and their use is only expected to increase. Computer Proficiency 

is an inevitable part of commerce education. The course is aiming to equip all 

the commerce aspirants to have basic skills as well as hands on experience on 

word processing, for creating excel spreadsheets, for building databases and 

preparing presentations, through the use of Microsoft Office Word, Excel, and 

PowerPoint programmes. By understanding the need Mangalmay Institute of 

Management and Technology organized a 48-hour Certification Program on 

Computer for B.com 2nd year students. 

The following topics covered under the course. 

Day 1: Introduction to MS OFFICE:This session starts with the brief 

introduction to MS OFFICE and the sub topics which are under MS OFFICE 

that is MS WORD, MS EXCEL, MS POWERPOINT and about INTERNET. 

This whole program of MS OFFICE consist of 4 units and the expert brief the 

topics. 

 



 
 

Day 2: Introduction To Ms Word  

Expert starts with MS WORD and under this he give detailed and practical 

exposure to the students about documents in MS Word. The expert taught 

about the Creating, editing, saving and printing text documents 

 

Day 3: Font and paragraph formatting and  Simple character formatting 

Inserting tables 

It is very important step as editing depend on the correct grouping and style. 

How to create the paragraph and how to group them would be taught in the 

class. The expert taught all the details about the formatting and also taught 

them how to insert tables in word file and how edit the same. Main aim is 

clear all the doubts regarding the editing and formatting. 

 

Day 4: Smart art, page breaks,  Using lists and styles 

The expert taught how to Create a SmartArt graphic so that they can quickly 

and easily make a visual representation of information. Also taught how to 

use page break for clarity purpose This type of section break is often used to 

change the number of columns without starting a new page. Even Page 

Section break starts a new section on the next even-numbered page. 

 

Day 5:  Working with images,  Using Spelling and Grammar check  

To make the word file more attractive the expert also taught how to insert 

images in file with the texts for support, and one more feature of word was 

discussed that was using of spelling and grammar check, Spell 

check documents manually or automatically as you type, or turn spell 

check off. Run grammar and spell checker manually to proof your writing 

 

Day 6:  Today the resource person discuss,  Understanding document 

properties, Mail Merge.The expert discuss about document properties and 

how to do mail merge 

 

Day 7:Introduction to MS Excel: Spreadsheet basics - A spreadsheet is a 

computer application that is designed to add, display, analyze, organize, and 

manipulate data arranged in rows and columns, Creating, editing, saving and 

printing spreadsheets 



 
 

 

Day 8: Today the resource person discuss,  Working with functions & 

formulas  Excel Formulas and Functions 

Experts explain the formulas  

● Sample Formula: "=SUM(C2:C4)" 

● “=AVERAGE(C2, C3, C4)” 

● Sample Formula: "=COUNT(C1:C4)" 

● “=SUBTOTAL(1, A2: A4)" 

● “=SUBTOTAL(4, A2: A4)” 

● “=MOD(A2,3)” 

● “= POWER (A2,3)” 

● "=CONCATENATE(A25, " ", B25)" 

 

Day 9:Today the resource person discuss, Modifying worksheets with color& 

auto formats, Apply an AutoFormat Style 

Highlight the data in the worksheet that you want to format. 

Go to the Quick Access Toolbar and select AutoFormat. 

1. In the AutoFormat dialog box, choose a style. 

2. Select OK to close the dialog box. 

3. The new style is applied to the table. 

4. Day 10: Today the resource person discuss, Graphically representing data : 

Charts & Graphs- Charts are used to make a graphical representation of any 

set of data. A chart is a visual representation of data, in which the data is 

represented by symbols such as bars in a bar chart or lines in a line chart. 

Day 11:Today the resource person discuss, Speeding data entry : Using Data 

Forms,  Analyzing data : Data Menu, Subtotal, Filtering Data Sort & 

Filtering- Go to the Home ribbon, click the arrow below the Sort & Filtering 

icon in the Editing group and choose Filter.  

Day 12:  Today the resource person discuss, Formatting worksheets, Securing 

& Protecting spreadsheets - On the Review tab, click Protect Sheet. In the 

Allow all users of this worksheet to list, select the elements you want people 

to be able to change. Move the pointer to cells for which the Locked box is 

checked on the Protection tab of the Format Cells dialog box. 

 

Day 13: Introduction to MS Power Point: Opening, viewing, creating, and 

printing slides. The expert explains the presentation tool in MS Office is MS 

PowerPoint. Give shortcuts to create, print, close & save a presentation 



 
 

Day 14: Today the resource person discuss, Applying auto layouts- Auto 

layout can be applied to anything. There are three ways to apply auto layout. 

Auto layout can be applied simply by pressing Shift + A after selecting the 

elements. An option to add Auto Layout appears in the Properties Panel (right 

bar), in the “Design” section when groups, frames, or any contents are 

selected. 

Day 15:  Today the resource person discuss, Adding custom animation 

1. Step1: Select the slide with the object you want to animate. 

2. Step 2: Select the object you want to animate. 

3. Step 3: Click the Animation Styles button on the Animations tab. 

4. Step 4: Select a motion path. 

5. Step 5: Click the Effect Options button. 

6. Step 6: Select an effect option. 

7. Step 7: Customize the effect as needed. 

 

Day 16:  Today the resource person discuss, Using slide transitions 

1. Select the slide you want to add a transition to. 

2. Select the Transitions tab and choose a transition. Select a transition to 

see a preview. 

3. Select Effect Options to choose the direction and nature of the 

transition. 

4. Select Preview to see what the transition looks like. 

 

5. Day 17: Today the resource person discuss, Graphically representing data : 

Charts & Graphs- Charts are used to make a graphical representation of any 

set of data. A chart is a visual representation of data, in which the data is 

represented by symbols such as bars in a bar chart or lines in a line chart. 

 

Day 18: Today the resource person discuss, Creating Professional Slide for 

Presentation 

1. To create a presentation from scratch, select Blank Presentation. 

2. To use a prepared design, select one of the templates. 

3. To see tips for using PowerPoint, select Take a Tour, and then select 

Create 

 

Day 19 Today the resource person discuss, Introduction to Internet: 

Understanding how to search/Google-Internet is a group of computer 

systems connected from all around the world. The Internet protocol suite is a 

framework defined through the Internet standards 
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Day 20:  Today the resource person discuss, Bookmarking, Going to a 

specific website 

Day 21:  Today the resource person discuss, Copy and paste Internet content 

into your word file and emails   

Day 22: Today the resource person discuss, Understanding social media 

platforms such as Facebook & Many more  

Day 23: The resource person discussed about global network of computers 

through internet. 

Outcome of 

Activity 

Students are able to learn and practice the MS OFFICE. which is being 

advance tool, it will increase their employability 
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Examination 

Sample Assessment 



 
 



 
 



 
 

 

  



 
 
 


